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About This Release
This document describes enhancements in ERDAS IMAGINE 2020 Update 3 (v16.6.3), including IMAGINE
Photogrammetry (formerly LPS Core) and ERDAS ER Mapper. Although the information in this document is
current as of the product release, see the Hexagon Geospatial Support website for the most current version.
Update 3 includes both enhancements and fixes. For information on fixes that were made to ERDAS
IMAGINE, see the Issues Resolved section.
This document is only an overview and does not provide all the details about the product's capabilities. See
the online help and other documents provided with ERDAS IMAGINE for more information.
Development of ERDAS IMAGINE 2020 ensures all aspects of ERDAS IMAGINE run in 64-bit. Consequently,
the installer has been split into three separate installers: ERDAS IMAGINE 2020 64-bit; ERDAS IMAGINE
2020 32-bit; and ERDAS ER Mapper 2020. The same split is available for Update 3 installers.

ERDAS IMAGINE Product Tiers
ERDAS IMAGINE performs advanced remote sensing analysis and spatial modelling to create added
information. You can also visualize results in 2D, 3D, or video and on cartographic-quality map compositions.
The core of the ERDAS IMAGINE product suite is scalable to your geospatial data. Optional modules (addons) provide specialized functions to enhance productivity.
IMAGINE Essentials is the entry-level image processing product for map creation and simple feature collection
tools. IMAGINE Essentials enables serial batch processing.
IMAGINE Advantage enables advanced spectral processing; image registration; mosaicking and image
analysis; and change detection capabilities. IMAGINE Advantage allows you to process parallel batches for
faster output.
IMAGINE Professional includes a production toolset for spatial modeling and advanced spectral,
hyperspectral, and radar processing. This tier includes ERDAS ER Mapper at no additional cost.
IMAGINE Photogrammetry maximizes productivity with state-of-the-art photogrammetric satellite and aerial
image processing algorithms.
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New Platforms
Full Installers
Starting with ERDAS IMAGINE 2020 Update 1, update installers became full installers, allowing you to either
install the update as a standalone (e.g., install ERDAS IMAGINE 2020 Update 3 without first installing ERDAS
IMAGINE 2020) or as an update to an existing install (e.g., installing ERDAS IMAGINE 2020 Update 3 without
first installing ERDAS IMAGINE 2020 Update 1). With full installers, you can no longer roll back an update to
the previous version (e.g., If ERDAS IMAGINE 2020 is updated with ERDAS IMAGINE 2020 Update 3,
uninstalling it removes ERDAS IMAGINE 2020 entirely). Consequently, “rolling back” now involves uninstalling
ERDAS IMAGINE and re-installing the desired previous version.

ArcGIS 10.7.x and ArcGIS 10.8.x
ERDAS IMAGINE 2020 Update 3 (32-bit) has been tested and is supported when using an installed and
licensed version of ArcGIS 10.6, 10.6.1, 10.7, 10.7.1, 10.8, or 10.8.1 to provide geodatabase support libraries.
Alternatively, the IMAGINE Geodatabase Support component (based on ArcGIS Engine 10.7) can be installed
to provide geodatabase support.

PostgreSQL & PostGIS
The PostGIS Features Proxy reader now supports PostgreSQL 13.2 with PostGIS 3.1.1.

Licensing
ERDAS IMAGINE 2020 installers no longer attempt to automatically install geospatial licensing tools as part of
the installer. If customers wish to use geospatial licensing tools, for example, to set up a floating/concurrent
license server, you must download Geospatial Licensing 2020 separately.
We strongly recommend upgrading to the newest version of Geospatial Licensing 2020. If you are unsure of
your current version, refer to the Microsoft® Windows Add or Remove Programs utility.
You can find the appropriate download in the Downloads section of the Hexagon Geospatial website.
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New Technology
New Photogrammetry Workflows in Spatial Modeler
Over the past several years, the amount of data from image acquisition systems have grown exponentially
due, in part, to the growth of lower-cost UAV platforms and constellations of satellites. This effect is seen not
only in the imagery’s spatial resolution but also in the frequency of acquisition, with daily revisit rates becoming
the norm. This trend increases the need to process data automatically and quickly.
Photogrammetry workflows (e.g., adjustment, ortho rectification, color balancing, mosaicing) are usually the
initial steps of data processing. To handle this large volume of imagery, you need photogrammetric solutions
that can detect new acquisitions automatically; instantly process data; scale up computing resources as
needed; and feed output to downstream geospatial processes.
Spatial Modeler is designed to solve these challenges by offering hundreds of operators that easily chain
together into models to solve complex geospatial problems.
With the ERDAS IMAGINE 2020 Update 2 release, we expanded Spatial Modeler’s capabilities by adding a
new suite of photogrammetry operators that perform project setup, automatic point measurement, triangulation
and mosaicing for scanned frame, and digital frame cameras.
In ERDAS IMAGINE 2020 Update 3, we continue this process by expanding the operators into the satellite
sensors via RPC and rigorous orbital pushbroom model support.
Note that many of these new operators require additional licensing in order to run as part of a spatial model
execution. This is generally noted in the Help for each operator.

Create Semi-Global Matching (SGM) Point Cloud

Note: This operator requires IMAGINE DSM Extractor licenses in order to run.
This operator extracts a dense point cloud from a pair of stereo images using Semi-Global Matching (SGM).
Unlike the Create SGM Point Cloud Output operator (which has been deprecated) the Create SGM Point
Cloud is a streaming operator that does not need to output the surface model to a file. This is more suited to
use in larger spatial models that perform downstream processing on the surface data.
Additionally, this operator offers a PostingSkipFactor option. The posting skip factor (a value of 1 or greater)
specifies how many pixels will be skipped in the stereo pair in the X and Y directions during terrain extraction.
Lower skip factor leads to denser point cloud output, and higher skip factor reduces computation time but
leads to a sparser point cloud output.
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Define Image Parameters for Orbital Pushbroom Model

This defines the parameters which describe an image collected using an orbital pushbroom sensor.
Additionally, parameters related to how the sensor is modelled or adjusted for the particular image may be
specified in the InterpolationType, InterpolationParameter, PolynomialOrders and StandardDeviations options.
This operator is provided to handle orbital pushbroom models for which the image parameters are not
automatically read by Spatial Modeler. The image parameters for known orbital pushbroom models may be
automatically obtained using the Read Image Parameters For Orbital Pushbroom Model operator.

Define Block Parameters for Orbital Pushbroom Model

This defines the parameters needed to create a block for the management of orbital pushbroom images.
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Read Image Parameters for Orbital Pushbroom Model

This operator reads the orbital pushbroom sensor model metadata associated with a given image file and
returns it as a dictionary containing ImageParameters as described in Define Image Parameters for Orbital
Pushbroom Model operator. There are many different satellite systems that use the orbital pushbroom sensor
model; however, the way the metadata is represented can vary from sensor to sensor. There is a dedicated
format decoder for each of the supported orbital pushbroom sensor types. This operator uses those decoders
to ingest the metadata and make it available in a common internal form defined in the "Define Image
Parameters for Orbital Pushbroom Model" operator.

Define Image Parameters for Rational Function Model

This defines the parameters which describe a collected image using a rational function sensor.

Define Block Parameters for Rational Function Model

This operator defines the dictionary needed to create a Rational Function Block. Currently, other than the
SensorCategory of RationalFunction which is automatically populated by this operator, there are no additional
parameters needed.
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Add Orthos to Block

Note: This operator requires IMAGINE Advantage licenses or higher in order to run.
The operator adds one or more ortho images to a block. The added ortho images can be used in operations
such as mosaicking where the block is used as input.

Read Image Parameters for Rational Function Model

This operator reads the rational function sensor model metadata associated with a given image file and
returns it as a dictionary containing ImageParameters as described in the Define Image Parameters for
Rational Function Model operator. There are several satellite systems that use the rational function sensor
model; however, the way the metadata represents can vary from sensor to sensor. There is a dedicated
format decoder for each of the supported rational function sensor types.. This operator uses those decoders to
ingest the metadata and make it available in a common internal form defined in the Define Image Parameters
for Rational Function Model operator.

New Artificial Intelligence Semantic Segmentation Operators for Spatial Modeler
Hexagon continues to add operators to Spatial Modeler. New (or modified) operators are outlined below, with
a brief description of their capabilities. See the ERDAS IMAGINE 2020 Help for complete details on each
operator, and visit the Hexagon Geospatial Community Spatial Recipes page for examples of spatial models
that use many of these capabilities.

Initialize Image Segmenter

This operator produces a Machine Intellect by training a deep neural network. You case use this Machine
Intellect to perform semantic segmentation on images using the Segment Image Using Deep Learning
operator.
Semantic Segmentation is a term more commonly used in computer vision and is increasingly used in remote
sensing. It is another term for the classical pixel level image classification in remote sensing. As such, all
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applications that start with image classification (e.g., land cover mapping, precision agriculture, and road
network detection) will benefit from this deep learning-based approach to image classification.
The Image Segmenter is trained using example image tiles (approximately 224 x 224 pixels) with
corresponding label images which show the class distribution in the training images.

Segment Image Using Deep Learning

This operator performs semantic segmentation on the input raster and assigns a class and probability that the
class is correct for each pixel. This is done using the trained deep learning-based image segmenter specified
on the MachineIntellect port.

For example, the screenshots below show a multi-class semantic segmentation of satellite data to identify
buildings, roads, etc.
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Updated Operators
Mosaic Images

Note: This operator requires IMAGINE Advantage licenses or higher in order to run.
The Mosaic Images operator now accepts a list of input filenames rather than requiring a block as input. This
enables you to mosaic existing ortho images.

Point Input

The Point Input operator has been enhanced to provide an input dialog that integrates with the Inquire Cursor.
This allows you to easily select the point location for input to a Spatial Model. For example, if you use the
Grow Region operator, you may want to use the Inquire Cursor to pick the location in which to grow.
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Spatial Model Editor Interface Improvements
The process of starting a new Spatial Model Editor panel has been difficult to navigate in the past. To make
this process easier and more consistent with starting other types of View, Update 3 includes a shortcut located
at Home tab > Window group > Add Views pulldown > Create New Spatial Model Editor.
We have also enhanced the Spatial Model Editor to persist the last state of the gridlines. Whichever state the
Show Gridlines checkbox is set will determine how it is set when a new Spatial Model Editor is started.

Format Support
ICEYE SLC
ICEYE’s small satellite SAR imaging constellation is customized for the high revisit rate and frequent delivery
of high-resolution imagery.
Interferometric processing has now been tested using the limited set of available sample SLC (single look
complex) datasets. Further optimizations will occur as additional samples are delivered.

RADARSAT Constellation Mission (RCM)
The RADARSAT Constellation Mission (RCM) is Canada's new generation of Earth observation satellites.
Launched on June 12, 2019, the three identical satellites provide daily images of Canada's vast territory and
maritime approaches, as well as images of the Arctic, up to four times a day. It also has daily access to 90
percent of the world's surface.

Maxar / DigitalGlobe WorldView Legion
Synthesized examples indicate the upcoming WorldView Legion sensor is supported via RPC and Orbital
Pushbroom geometric models for orthorectification and other photogrammetric processing.

PRISMA L2D
PRISMA L2D hyperspectral data delivered in HDF5 format (.he5) now geolocates correctly.

Defense Gridded Elevation Data (DGED)
The Defense Gridded Elevation Data (DGED) reader now recognizes more vertical coordinate reference
systems that can be defined in the data and correctly interprets the data as elevation rather than simply an
image.
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DiMAP v2 NoData
DiMAP v2 data (e.g., SPOT, Pleiades, Pleiades Neo, etc.) XML headers often define a NoData value. This
value is now automatically used as the NoData value in ERDAS IMAGINE.

Pleiades Neo DiMAP Geometric Models
Pleiades Neo imagery is supported in both rigorous Orbital Pushbroom and RPC geometric models.

General ERDAS IMAGINE
Multi-band Thematic display
In previous updates, a multi-band thematic dataset,such as what is produced by ERDAS IMAGINE’s
supervised fuzzy classification tools, would default to open as a True Color display type. This default could be
visually confusing. We have updated this display to ensure that despite the number of bands present in an
image, if the first band is marked as thematic, the data will default to opening as Pseudo Color (band 1).

Escape Key
You can now dismiss dialogs using the industry-standard method of pressing the Esc key.

Lagrange Resampling
The Lagrange resampling method is now supported in IMAGINE Autosync (a part of the IMAGINE Expansion
Pack product) and MosaicPro.
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SIPS v2.4.15
We have updated the installer to use the Unclassified SIPS v2.4.15 XML file to control default Image Chain
display parameters.
You can acquire extended versions of SIPS via the IMAGINE Defence Productivity Module (DPM).

IMAGINE Digital Surface Model (DSM) Extractor
You can now define a spatial subset to limit the area in which the Digital Surface Model (DSM) is extracted.
We have introduced a posting skip factor which specifies how many pixels will be skipped in the stereo pair in
the X and Y directions during terrain extraction. Lower skip factor leads to denser point cloud output, and
higher skip factor reduces computation time but leads to a sparser point cloud output.

IMAGINE SAR Feature
We have implemented two new classes of speckle suppression algorithms, including:

Artificial Intelligence Convolutional Neural Network (CNN) Despeckle
This function will process the radar image through a convolutional neural, network-based algorithm specifically
trained to minimize speckle noise. This algorithm is fully automated and requires no user input.

Anisotropic and SuperPixel
This dialog enables the application of two sequential algorithms for a radar image. The first option, Despeckle,
offers two forms of Anisotropic radiometric reconstruction – the Mixed-Norm algorithm and the Feature
Preserving algorithm. Optionally, this step can be omitted by selecting “none”.
The intermediate image from the Despeckle step is followed by the second Segmentation step. The
Superpixel algorithm evaluates the pixel values (greyscale) and modifies them to produce coherent regions
(i.e., sub-features). The Cluster version of the algorithm also reduces pixel size. Again, selecting "none"
eliminates this step from the processing.
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System Requirements
ERDAS IMAGINE
Computer/ Processor

64-bit: Intel 64 (EM64T), AMD 64, or equivalent (four or more logical processors are strongly
recommended)

Memory (RAM)

16 GB or more strongly recommended

Disk Space

Operating Systems

2, 3,

4

Software

Recommended
Graphics Cards for
Stereo Display 6

Recommended Stereo
Display Monitors
Recommended Stereo
Glasses and Emitter
kits

•

6 GB for software

•

7 GB for example data

•

Data storage requirements vary by mapping project 1

•

Windows 10 Pro (64-bit)

•

Windows 10 Enterprise (64-bit)

•

Windows Server 2016 (64-bit)

•

Windows Server 2019 (64-bit)

•

OpenGL 2.1 or higher (this typically comes with supported graphics cards 5)

•

Java Runtime 1.7.0.80 or higher - IMAGINE Objective requires JRE and can utilize any installed
and configured JRE of version 1.7.0.80 or higher

•

Python 3.6.x or 3.7.x (Python is optionally usable with Spatial Modeler)

•

Microsoft DirectX® 9c or higher

•

.NET Framework 4.7.2 or higher

•

OpenCL 1.2 with a device that supports double precision (cl_khr_fp64) if wanting to GPU accelerate
NNDiffuse and other Operators

•

An NVIDIA card with CUDA capabilities is recommended for use with Deep Learning.

•

NVIDIA® Quadro® P6000, P5000, P4000, P2000

•

NVIDIA® Quadro® M6000, M5000, M4000, M2000

•

NVIDIA® Quadro® K5200, K5000, K4200, K4000, K2200, K600, K420

•

NVIDIA Quadro RTX4000

•

120 Hz (or above) LCD Monitors with NVIDIA 3D Vision™ Kit, or

•

3D PluraView system from Schneider Digital 7

•

Vision Engineering CONTOUR 3D stereoscopic GIS display

•

NVIDIA 3D Vision™ Kit

•

3DTV universal Emitter

All software installations require:
•

One Windows-compatible mouse with scroll wheel or equivalent input device

•

Printing requires Windows-supported hardcopy devices 8

Software security (Hexagon Geospatial Licensing 2020) requires one of the following:

Peripherals

•

Ethernet card, or

•

One USB port for hardware key

Advanced data collection requires one of the following hand controllers: 9
•

TopoMouse™ or TopoMouse USB™

•

Immersion 3D Mouse

•

MOUSE-TRAK

•

Stealth 3D (Immersion), S3D-E type, Serial Port

•

Stealth Z, S2-Z model, USB version

•

Stealth V, S3-V type (add as a serial device)
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ArcGIS and GeoMedia
Interoperability

•

3Dconnexion SpaceMouse Pro 10

•

3Dconnexion SpaceExplorer mouse 10

•

EK2000 Hand Wheels

•

EMSEN Hand Wheels

•

Z/I Mouse

•

ERDAS IMAGINE can be safely installed on a computer that has GeoMedia 2018 or GeoMedia
2020 installed; however, for greatest compatibility, it is highly recommended to install matching
versions (including updates).

•

ERDAS IMAGINE 2020 requires GeoMedia 2020 for live linking. Order of installation does not
matter.

•

ERDAS IMAGINE can interact with both types of personal Geodatabases (*.mdb and *.gdb).

•

ERDAS IMAGINE can be safely installed on a computer that has ArcGIS® versions 10.6 through
10.8.1.

•

ERDAS IMAGINE and IMAGINE Photogrammetry (32-bit) can interact with ArcGIS Server 10.6 –
10.8.1 Geodatabase servers (ArcSDE). To read or interact with an Enterprise Geodatabase, you
must either:
o

Install and license the appropriate version of ArcGIS for Desktop versions 10.6
through 10.8.1, OR

o

Install the IMAGINE Geodatabase Support (based on ArcEngine 10.7) - requires no
license

•

PostgreSQL 13.2 with PostGIS 3.1.1: PostGIS can be used to store GeoMedia Features (.pfp)

•

Oracle Server 12c 12.2 64-bit: Oracle Server 12c can be used to store Oracle GeoRaster (.ogr)
(requires Oracle Spatial), SDE Raster (.sdi) (requires ArcGIS for Server) and Oracle Spatial
Features (.ogv) (requires Oracle Spatial), as well as GeoMedia Features (.ofp).

•

Microsoft SQL Server 2017 64-bit: Microsoft SQL Server 2017 can be used to store GeoMedia
Features (.sfp)

Database Engines

ERDAS IMAGINE System Requirements Notes
1

Disk I/O is usually the slowest task in geospatial data processing. Faster hard disks improve productivity.
Reading data from one disk, writing temporary data to a second disk, and writing data to a third disk improves
performance. Disk arrays improve productivity, but some RAID options slow performance. Network disk drives
are subject to network limitations.
2 Server

Operating Systems are not supported for IMAGINE Photogrammetry, ORIMA, or ERDAS ER Mapper.

3

The 3D stereo viewing and peripheral requirements of IMAGINE Photogrammetry limit its operating system
options.
4

ERDAS ER Mapper is not supported on Windows 8. It is considered Viable on Windows 8.1.

5

Windows provides a generic OpenGL driver for all supported graphics cards; however, an OpenGLoptimized graphics card and driver are recommended for these applications.
6

Graphics cards certified with previous versions of IMAGINE Photogrammetry and ORIMA may also be
compatible but are not certified in the current version. Drivers must not be newer than R418. NVidia dropped
3D Vision support for drivers released after R418 U4 (425.31), which was released on April 11, 2019.
7

Stereo Monitors certified with previous versions of IMAGINE Photogrammetry and ORIMA may also be
compatible but are not certified in the current version.
8

HP-RTL drivers are recommended. Windows 64-bit print servers require 64-bit print drivers.

9

Stealth S-Mouse (S2-S model) and MOUSE-TRAK are the only supported hand controllers in Stereo Analyst
for ERDAS IMAGINE.
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10

3Dconnexion mice are supported in IMAGINE Photogrammetry.
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Issues Resolved – ERDAS IMAGINE 2020
Update 3
IMAGINE Essentials
Issue ID

Summary –
IMAGINE
Essentials

Description / How to Reproduce

00074497

Raster edit
Recode doesn’t
update the
Contents legend
entry

ERDAS IMAGINE 2020 Update 2
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Make a local copy of a thematic image with, for example, 9 classes
Display the image in a 2D View
Expand the Contents treeview so you can see the legend of the classes
Thematic tab > Edit group > Recode
Select rows 5 - 8 and change their New Value to 1
Click Apply
You should see the colors change in the View
Click the Save icon at top left
Say yes to the warning message
Now bring up the Raster Attribute Editor (Table tab > Show Attributes) and note that you
successfully got rid of all but 5 entries.

But Contents still shows all 9
00062249

Multipoint
Geometric
Correction
("warptool")
crashes when
used with Bing
Maps reference

Customer reports that the Multipoint Geometric Correction tool crashes "from time to time" during
georeferencing. As a reference Bing Maps is used with a Basic Key. Before local data was used
without problems. For the current region there is no local data available and that's why Bing Maps
is used.
In the session log attached near the end there are a lot of entries saying:
"SessionMgr(14900): Image block count exceeds 2^32"
Then the log ends with:
"SessionMgr(14900): warptool.exe exited with status 255."
Steps to replicate:
1. Open a local image file without reference in ERDAS IMAGINE
2. Prior to geoferencing, the customer calculates pyramids and statistics for this image
3. Open Multipoint Geometric Correction tool (Panchromatic > Transform & Orthocorrect > Control
Points)
4. Choose "Polynomial" as Geometric Model
5. Choose the option "Bing Aerial Layer" for "Collect Reference Points From"
6. Keep default target projection "Pseudo Mercator / WGS 84"
7. Maximise the Multipoint tool
8. Start georeferencing: Zoom into the view with the unreferenced image, set the first point there,
and afterwards set the corresponding reference point in the Bing Maps view
9. Repeat step 8 several times, but the last time try to swap the order for placing the points (set
reference point > set unreferenced point). The placement of the reference point already causes the
warptool to crash.

00071901

Some Sentinel-2
data fails to open
with error “image
file is missing"

All three of the Sentinel-2 importers fail to import some Sentinel-2 data resulting in the error “image
file is missing”. According to the data’s manifest.safe file this is Level-1C data, but it appears to be
labelled incorrectly. The data is actually Level 2A.

00073793

ERDAS IMAGINE
fails to read the
projection for a
shapefile from a
Dutch Web
Feature Service

Customer provided a shapefile that is derived from a Dutch Web Features service. When opening
the shapefile in the 2D View or SMSDK, EPRJ fails to create a CRS even though the PRJ file is
recognized by PE and is a valid description of the CRS for Amersfoort/ RD New, EPSG Code
28992.
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00071834

ERDAS IMAGINE
doesn't display all
attributes from
HPC format
(exported from
LAS)

To reproduce:
1.
2.
3.
4.

Run Manage Data > Export Data
Pick Hexagon Point Cloud (HPC) as Format, define a .las file as Input File and provide
output filename. Click Ok.
In the opened dialog window activate Include Attributes option and click OK.
Load the resulting .hpc file to the 2D View and open attribute table (Table tab > Show
Attributes). Intensity, Return and Class will have all 0s

This is an ERDAS IMAGINE display issue, attributes are being written correctly:
the attributes are being written but ERDAS IMAGINE isn’t reading them when displaying the
attribute table. ERDAS IMAGINE also only renders HPC point clouds by RGB for performance
reasons.
I.e. the HPC files are attributed correctly but some work was required to expose them to 2D View
users.
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IMAGINE Advantage
Issue ID

Summary – IMAGINE
Advantage

Description / How to Reproduce

00070615

Resolution Merge fails to
complete when writing to
TIFF with Japanese
system locale (32-bit)

The issue with Japanese system locale and writing TIFF output in Model Maker based tools
present in ERDAS IMAGINE 2020 Update 1.
Related to 32-bit installer only:
1.
2.
3.
4.

5.
6.

Change system locale to Japanese. Control Panel>Region>Administrative tab>Change
System Locale>Japanese (Japan)
Run ERDAS IMAGINE 2020 32-bit
Go to Raster > Pan Sharpen > Resolution Merge
Define:
a. High Resolution - QuickBird_Pyramids_Pan.img
b. Multispectral Input - QuickBird_Pyramids_MS.img
c. Output file - specify filename and pick TIFF as Files of Type
d. Output Data Type - Unsigned 16 bit
You will get the red progress bar at the end and the following status in session log:
modeler.exe exited with status -1073740940.
But TIFF file is still successfully written together with pyramids

00072352

OLH missing for Raster
> Change Detection
'Feature to Feature' and
'Chart to Chart'

Raster tab > Change Detection group > Change Detection Tools 'Feature to Feature' and
'Chart to Chart' program do not have OLH pages.

00067106

MosaicPro omitting
images at the corners
(GDA2020 datum)

To reproduce, load images to MosaicPro and run mosaic producing ECW output data (looks
like issue is not dependent on the output format, but customer initially needed to create ECW
output). The output mosaic will miss one image at the top right corner. Customer is having
multiple sets of data, where either one or two images at corners are missing in output
mosaic.

00067045

MosaicPro output shows
seam gaps which follow
seamline polygon edges

A single pixel gap / hole is generated in MosaicPro output. The gap follows the seamline
polygon (.shp) used in the mosaic.
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IMAGINE Objective
Issue ID

Summary – IMAGINE
Objective

Description / How to Reproduce

00072036

Objective's PC Centerline
pixel cue is removed from
software but PC Centerline
is still documented in OLH.

PC Centerline pixel cue is documented to be included in the Objective software but the
option has been removed from Objective.

00067532

The Objective Raster Object
Creator Segmentation
operator generates
unexpected results when
using ‘Output Processing >
Extent / AOI’ options

Layer images with vertical artifacts (i.e. strips) are generated when running an Objective
model that uses Output Processing > Extent / AOI options (From Inquire Box, From
File, From AOI, Manual). The Manual option works correctly if the default full image
extent is used.
The problem may be isolated to the ROC Segmentation operator. The problem is not
observed using the ROC Segmentation_Lambda Schedule operator.
To recreate:
1.

2.
3.
4.
5.

Run Objective, open existing project ‘exclude_building.lfp’. The model should
open starting at the Raster Pixel Processor node and stopping at the Raster
Object Creator node.
Select Process menu > Output Process Settings…
Select Extent / AOI tab
Select From File, then select subset.img, then OK
Run model

00067145

Objective ROC –
Segmentation Plug-in layer
hanging with some input
images

The Objective ROC Segmentation Plug-in layer process runs until the ROC Progress
meter stops at 92%. The ROC process must be manually killed before Objective can be
run again. If the full input image is divided into quarters, each quarter can be processed
completely by the ROC Segmentation Plug-in. If the full image is divided into halves
(top, bottom), the top half completes normally, but the bottom half hangs in the same
manner as when using the full input image.

00072251

IMAGINE Objective process
cannot be started later with
Batch tool

Customer wanted to run their IMAGINE Objective feature model process in batch mode
so that they can start the processing at a later time, but it does not work. If the user
chooses the “Submit > Start Processing Now” option from the Batch Command Editor
their feature model process runs as expected. But if they choose “Submit > Start
Processing Later At…” it does not work.
Steps to reproduce the problem.
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Copy the files rooftops.lfp, rooftops.lfm and residential.img to a local directory.
Start IMAGINE Objective.
Open the feature project file rooftops.lfp.
Click on the Process menu and choose “Batch Objective Process”.
In the Batch Command Editor click the Submit button.
Choose the “Start Processing Later At…” option.
Click the Credentials button and enter your user credentials then click OK.
Adjust the start time so that it is a minute ahead.
Click OK.
The process starts and finishes very quickly. No processing occurs and no
output files are created.
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IMAGINE Photogrammetry
Issue ID

Summary – IMAGINE
Photogrammetry

Description / How to Reproduce

00071724

Very dense vertex
interpolation during
breakline editing

While moving a breakline over another existing breakline new vertices are immediately
(on the fly) interpolated on the moved and on the overlapping breakline. The vertices of
both breaklines get an extreme density of interpolated vertices while moving and not
only at the end of the move (when releasing the Create/Edit button).

00071726

Breakline measurement
cause problems near other
breaklines

An accidental editing of a breakline vertices happens when a new breakline is digitized
near an existing breakline which is within the “selection radius”. The adjacent breakline
point(s) will be shifted then. An “Undo” sometimes result in unexpected effects. These
are for example: the adjacent breakline disappears (Redo could fix this problem) or the
adjacent breakline appers twice (old and new position).

00074735

IMAGINE DSM Extractor
interface image pair
threshold issue

Have a block file with 7 images with 80% overlap.
When opening in the DSM Extractor interface it calculates/shows the rows with pairs
based on 50% overlap or more. That is all normal. When I select 80% overlap or more it
still shows the same amount of rows however now with many empty ones. Yet when I
lower the percentage to 40% it still shows the same amount of rows in the preview even
though there are more pairs now (15).
So it still shows 11 rows, 4 pairs are missing which will not be considered. When
pressing Run Now it will only take those selected out of these 11 options, the other 4 will
automatically not be used. When pressing Submit all 15 pairs do appear.

00071725

Points and Breaklines are
sometimes duplicated after
editing in Terrain Editor

When zooming in and out after having moved/edited a point or a breakline the edited
element sometimes is displayed twice (old and new position). When executing “Save”
afterwards the elements in the LTFX file are really existing twice (old and new).
Try to move some height points (4 to 5) with the Point Tool from one position to another
(move in xyz). Then zoom in and out a couple of times. Try to do the same with
breakline vertices using the Breakline Tool.

00071725

Terrain Editor: Points and
Breaklines are sometimes
duplicated after editing

When zooming in and out after having moved/edited a point or a breakline the edited
element sometimes is displayed twice (old and new position). When executing “Save”
afterwards the elements in the LTFX file are really existing twice (old and new).

00028810

WorldView image
processing issues in SGM
Tridicon

Customer is generating point clouds in Tridicon SGM using WorldView imagery.
There are a lot of bad matches in Tridicon SGM outputs. It looks like accurate surface
points are in there, but they are surrounded by several high and low anomalous
points. Customer has created several iterations of blockfiles using various in-track
stereo WV3 imagery, multiple formats (NTF and GeoTIFF), varying #’s of GCPs and
tiepoints, and have ran SGM using the different pyramid and disparity levels, but still
getting similar results. Triangulation results are good.

00046100

Import tool imports INPHO
project with wrong flying
height.

When importing Inpho project to block file; at project import default unit is meters, and
when you enter units as US Survey Feet importer makes a conversion from meters to
US Survey feet which it shouldn’t because project is triangulated in US Survey feet.
Defining the INPHO projection units should not result in unit conversion.
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IMAGINE Professional
Issue ID

Summary – IMAGINE
Professional

Description / How to Reproduce

00072928

Knowledge classification
not working

IMAGINE Professional 2020 with or without Update 2 crashes when trying to complete
knowledge engineering workflow

00073991

Update help
documentation for
creating custom spectral
library

When attempting to open a custom spectrum library in the Working Materials Libraries
panel the Spectral Analysis Workstation crashes. No error messages are observed, but the
session log reports “imagespectrometry.exe exited with status -1073741819."
It appears that the header information in the library file is causing this problem. Although the
help documentation states that only six fields are required (Name, Type, Class, First X
Value, First Y Value, Number of X Values), you actually need to have two more fields (X
Units, Y Units).

00073803

Subpixel Preprocessing
tool does not work in
ERDAS IMAGINE 2020
Update2 64-bit

The Subpixel Classifier’s Preprocessing tool does not work in the 64-bit version of ERDAS
IMAGINE. The progress meter gets to 2% before it fails. The session log reports
“aaipreprocess.exe exited with status -1073740791." It works in the 32-bit version of
ERDAS IMAGINE 2020.
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Spatial Modeler
Issue ID

Summary – Spatial
Modeler

Description / How to Reproduce

00072486

OLH for ‘Create SGM
Point Cloud Output’ has
typo

OLH for ‘Create SGM Point Cloud Output’ has a typo:

00071951

Including Add
Background Row
operator to a String table
will crash ERDAS
IMAGINE.

There is an issue with the "Add Background Row" operator. If the input for this operator
is a sting table Spatial Modeler / ERDAS IMAGINE crashes.

00005283

Setting AOI without
Georeferencing Doesn't
work on Raster Input

Create an AOI on top of an image without map/projection information. Create a Raster
Input giving it the AOI created. Preview. See nothing.

00073007

smprocess crashes
during initialization of
custom products with
Update2

When custom DLLs with SpatialModeler extensions are present, smprocess crashes
regularly but unfortunately the crashes cannot be reproduced easily. This seems to be a
problem with ERDAS IMAGINE 2020 Update 2. As a consequence, certain third-party
developed and sold add-on products crash frequently and can therefore not be used with
ERDAS IMAGINE 2020 Update 2.

The operator checks for IMAGINE_SGM license. For ERDAS IMAGINE 202 Update 2, it
can also be unlocked with AutoDTM license.

Engineering tracked down the problem to be related to the specification of the
SearchPaths in the DLLs XML configuration.
00068746

'Features Output'
operator creates .csv
with double-quotes
around numeric attributes
causing other
applications to interpret
the values as text

When using the 'Features Output' operator and selecting 'GeoCSV (.csv)" as the type for
the FileNameIn port the output .csv file that is created will contain double quotes (")
around numeric attribute values. For instance, I created a very simple spatial model with
just a 'Features Input' operator and a 'Features Output' operator where the output was
GeoCSV. When the model is run and a shapefile containing a attribute of type Integer is
used as input to the 'Features Input' operator the resulting .csv file from the 'Features
Output' operator will contain double quotes around each of the Integer values. The
contents of the .csv file as output from the Features Output operator using my model and
input shape file is shown below:
PrimaryKey,Text1,Integer1,ID1
"1",Eleven,"11","1"
"2",TwentyFour,"24","2"
"3",ThreeHundredSeventySix,"376","3"

00072855

Error opening Block file
that was created in the
Spatial Modeler

A customer pointed us at an issue where he created a Block File in the Spatial Modeler.
When opening the resulting Photogrammetric Project in a 2D View, the block file did
open, however when going to Interior Orientation an error occurred. This error also
meant that the PixelSizeX and PixelSizeY were reset to 0 for all images, meaning this
had to be redone. This issue does not always occur.
It was found that if using non-standard axis orientations (Down+X, Left+X and Up+X)
they do not work properly and cause this issue.

00073945

ERDAS IMAGINE taking
3x longer to preview the
result of Clump +
Convert To Features

To reproduce:
The dem_differencing_update1.gmdx model has been created in ERDAS IMAGINE
Update 1. Try to run the Preview with associated data This model runs within 1 minute in
Update 1 (as well as Update 2)
In dem_differencing_update2.gmdx model, Convert To Features and Clump operators
have been replaced with new ones. For the new requirement of new Clump operator,
additionally 0s have been defined as NoData. Try to run the Preview with associated
data. ERDAS IMAGINE will become unresponsive (i.e. you are in danger of getting the
"Not Responding" dialog) and produce the result within 3 minutes 32 seconds.
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00072977

Features Input operator
fails to read data if
filename/path includes
"&"

To reproduce:
1.
2.

The data should be located in folder named "data & model" or create any other
folder that will include the “&” symbol.
Run data_prep_extract_rooftops.gmdx with associated files. It will read raster
file successfully but Features Input will fail with "Cannot open specified Vector
source" error.

Full Message is
Cannot open specified Vector source (erdas::sb_CGP::FeaturesInput::OnExecute failed)
00077250

Issue with
orthorectification of
ALOS PRISM data in
Spatial Modeler

Orthorectify without GCP tool is producing the expected output with ALOS PRISM
data, while trying to replicate the same workflow in Spatial Modeler gives wrong result
(either left or right part of image getting clipped out)
This issue is addressed in Update 3 by using the new satellite photogrammetry
operators.
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Contact Us
https://go.hexagongeospatial.com/contact-us-today

About Hexagon
Hexagon is a global leader in sensor, software, and autonomous solutions. We are putting data to work to
boost efficiency, productivity, and quality across industrial, manufacturing, infrastructure, safety, and mobility
applications.
Our technologies are shaping urban and production ecosystems to become increasingly connected and
autonomous — ensuring a scalable, sustainable future.
Hexagon’s Geospatial division creates solutions that deliver a 5D smart digital reality with insight into what
was, what is, what could be, what should be, and ultimately, what will be.
Hexagon (Nasdaq Stockholm: HEXA B) has approximately 21,000 employees in 50 countries and net sales of
approximately 4.4bn USD. Learn more at hexagon.com and follow us @HexagonAB.
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Copyright
© 2021 Hexagon AB and/or its subsidiaries and affiliates. All rights reserved. Hexagon has registered
trademarks in many countries throughout the world. Visit the Trademarks Page
http://www.hexagongeospatial.com/legal/trademarks for information about the countries in which the
trademarks are registered. See Product Page and Acknowledgments for more information.

Product Documentation Terms of Use
PLEASE READ THESE TERMS CAREFULLY BEFORE USING HEXAGON GEOSPATIAL’S
DOCUMENTATION ("DOCUMENT"). USE OF THIS DOCUMENT INDICATES ACCEPTANCE OF THIS
AGREEMENT WITHOUT MODIFICATION. IF YOU DO NOT AGREE TO THE TERMS HEREOF ("TERMS"),
DO NOT USE THIS DOCUMENT.

Use Of This Document
All materials in this Document are copyrighted and any unauthorized use may violate worldwide copyright,
trademark, and other laws. Subject to the terms of this Agreement, Hexagon Geospatial (a Division of
Intergraph Corporation) and Intergraph’s subsidiaries ("Intergraph") hereby authorize you to reproduce this
Document solely for your personal, non-commercial use. In consideration of this authorization, you agree to
retain all copyright and other proprietary notices contained therein. You may not modify the Materials in any
way or reproduce or publicly display, perform, or distribute or otherwise use them for any public or commercial
purpose, except as specifically authorized in a separate agreement with Hexagon Geospatial.
The foregoing authorization specifically excludes content or material bearing a copyright notice or attribution of
rights of a third party. Except as expressly provided above, nothing contained herein shall be construed as
conferring by implication, estoppel or otherwise any license or right under any copyright, patent, or trademark
of Hexagon Geospatial or Intergraph or any third party.
If you breach any of these Terms, your authorization to use this Document automatically terminates. Upon
termination, you will immediately destroy any downloaded or printed Materials in your possession or control.

Disclaimers
ALL MATERIALS SUPPLIED HEREUNDER ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT. Hexagon Geospatial does not warrant that the content of this Document will be error-free,
that defects will be corrected, or that any Hexagon Geospatial Website or the services that make Materials
available are free of viruses or other harmful components.
Hexagon Geospatial does not warrant the accuracy and completeness of this Document. Hexagon Geospatial
may make changes to this Document at any time without notice.

Limitation Of Liability
IN NO EVENT SHALL HEXAGON GEOSPATIAL BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL OR CONSEQUENTIAL DAMAGES, OR DAMAGES FOR LOSS OF PROFITS, REVENUE, DATA
OR USE, INCURRED BY YOU OR ANY THIRD PARTY, WHETHER IN AN ACTION IN CONTRACT OR
TORT, ARISING FROM YOUR ACCESS TO, OR USE OF, THIS DOCUMENT.

Indemnification
You agree to defend, indemnify, and hold harmless Hexagon Geospatial, its officers, directors, employees,
and agents from and against any and all claims, liabilities, damages, losses or expense, including reasonable
attorneys' fees and costs, arising out of or in any way connected with your access to or use of this Document.

Use Of Software
Use of software described in this Document is subject to the terms of the end user license agreement that
accompanies the software, if any. You may not download or install any software that is accompanied by or
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includes an end user license agreement unless you have read and accepted the terms of such license
agreement. Any such software is the copyrighted work of Hexagon Geospatial, Intergraph or its licensors.
Portions of the user interface copyright 2012- Telerik AD.

Links To Third Party Websites
This Document may provide links to third party websites for your convenience and information. Third party
websites will be governed by their own terms and conditions. Hexagon Geospatial does not endorse
companies or products to which it links.
Third party websites are owned and operated by independent parties over which Hexagon Geospatial has no
control. Hexagon Geospatial shall not have any liability resulting from your use of the third-party website. Any
link you make to or from the third party website will be at your own risk and any information you share with the
third party website will be subject to the terms of the third party website, including those relating to
confidentiality, data privacy, and security.

Trademarks
The trademarks, logos, and service marks ("Marks") displayed in this Document are the property of Hexagon
Geospatial, Intergraph or other third parties. Users are not permitted to use Marks without the prior written
consent of Hexagon Geospatial, Intergraph or the third party that owns the Mark. "Intergraph" is a registered
trademark of Intergraph Corporation in the United States and in other countries. Other brands and product
names are trademarks of their respective owners.
Find additional trademark information https://www.hexagongeospatial.com/legal/trademarks.

Procedure For Making Claims Of Copyright Infringement
Notifications of claimed copyright infringement should be sent to Hexagon Geospatial by mail at the following
address: Intergraph Corporation, Attn: Intergraph Legal Department, P.O. Box 240000, Huntsville, Alabama
35824.

US Government Restricted Right
Materials are provided with "RESTRICTED RIGHTS." Use, duplication, or disclosure of Materials by the U.S.
Government is subject to restrictions as set forth in FAR 52.227-14 and DFARS 252.227-7013 et seq. or
successor provisions thereto. Use of Materials by the Government constitutes acknowledgment of Hexagon
Geospatial or Intergraph’s proprietary rights therein.

International Use
You may not use or export Materials in violation of U.S. export laws and regulations. Hexagon Geospatial
makes no representation that Materials are appropriate or available for use in every country, and access to
them from territories where their content is illegal is prohibited.
Hexagon Geospatial provides access to Hexagon Geospatial international data and, therefore, may contain
references or cross references to Hexagon Geospatial products, programs and services that are not
announced in your country. These references do not imply that Hexagon Geospatial intends to announce such
products, programs, or services in your country.
The Materials are subject to U.S. export control and economic sanctions laws and regulations and you agree
to comply strictly with all such laws and regulations. In addition, you represent and warrant that you are not a
national of, or otherwise located within, a country subject to U.S. economic sanctions (including without
limitation Iran, Syria, Sudan, Cuba, and North Korea) and that you are not otherwise prohibited from receiving
or accessing the Materials under U.S. export control and economic sanctions laws and regulations. Hexagon
Geospatial makes no representation that the Materials are appropriate or available for use in every country,
and access to them from territories where their content is illegal is prohibited. All rights to use the Materials are
granted on condition that such rights are forfeited if you fail to comply with the terms of this agreement.
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Revisions
Hexagon Geospatial reserves the right to revise these Terms at any time. You are responsible for regularly
reviewing these Terms. Your continued use of this Document after the effective date of such changes
constitutes your acceptance of and agreement to such changes.

Applicable Law
This Document is created and controlled by Hexagon Geospatial in the State of Alabama. As such, the laws of
the State of Alabama will govern these Terms, without giving effect to any principles of conflicts of law. You
hereby irrevocably and unconditionally consent to submit to the exclusive jurisdiction of the United States
District Court for the Northern District of Alabama, Northeastern Division, or the Circuit Court for Madison
County, Alabama for any litigation arising out of or relating to use of this Document (and agree not to
commence any litigation relating thereto except in such courts), waive any objection to the laying of venue of
any such litigation in such Courts and agree not to plead or claim in any such Courts that such litigation
brought therein has been brought in an inconvenient forum. Some jurisdictions do not allow the exclusions or
limitations set forth in these Terms. Such exclusions or limitations shall apply in all jurisdictions to the
maximum extent allowed by applicable law.

Questions
Contact us with any questions regarding these Terms.
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